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Power BI is a Microsoft-powered business intelligence tool that helps

transform raw data into interactive dashboards and actionable insights. It allow

users to connect to various data sources, clean and shape data and visualize it

using charts, graphs and reports all with minimal coding.

It’s widely used in industries for data storytelling, decision-making and

analytics and integrates well with tools like Excel, databases, Cloud and even

Python. Tools like Microsoft Power BI are used by over 3000 companies for

business intelligence.

What is Power BI Used For?

Power BI is a tool that helps you understand your data better. you can:

Bring in data from different places like Excel files, SQL databases, CSVs,

JSON files and even websites.

Clean and fix your data easily without writing code.

Create visuals like bar charts, line graphs, pie charts and dashboards to help

you see patterns and trends.
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Analyze your data using filters and slicers, so you can focus on specific

details like sales by region or product performance over time.

Share your dashboards with your team or clients so everyone stays informed

and can explore the data on their own.

Set up automatic updates so your reports always show the latest

information without you having to do anything.

The tutorial is divided into 5 sections and each section provides you the

necessary materials to progressively learn Power BI. As you complete each

section you move forward to your goal of becoming a Power BI specialist.

Section 1: Power BI - Introduction & Setup

In this section We will start with an introduction to Power BI, learn how to

install it and understand the basic settings required to get started. Additionally

we will cover the key components of Power BI, its real-world applications and

compare it with tools like SSRS.

PowerBI Installation

What is Power BI and Why Power BI in Data Analysis

Power BI Components

Practical Applications

Advantages of Power BI, Disadvantages of Power BI

Differences Between Microsoft Power BI and SSRS

Power BI Free vs Power BI Pro vs Power BI Premium

Section 2: Power BI - Query Editor

Now we’ll explore how to clean and shape data using Power BI’s Query Editor.

You’ll learn how to transform values, create conditional columns, group data

and merge queries. By the end you’ll be able to prepare datasets effectively for

analysis.

Query Editor in Power BI

Working with Numbers in Power BI

Working with Date & Time Tools

Conditional Columns in Power BI

Grouping & Aggregating Records
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Merge and Append Queries in Power BI

Manage data source settings and permissions

Data refresh in Power BI

Power BI Data Types

Power BI – Excel Integration

Section 3: Power BI Dashboard and Visualization 

Wll learn how to build interactive dashboards and bring data to life with

visualizations in Power BI. You’ll discover how to use charts, filters, slicers,

maps and KPIs to explore data and share insights

Creating a dashboard

Inserting Basic Charts & Visuals in Power BI

Build table relationship and Data models

Conditional Formatting

How to add Reports to Dashboards

Using Charts: Bar, Column, Area, map, Waterfall, Tree map, Table

Adding Trend Lines & Forecasts

Power BI Report Filtering Options

Exploring Data with Matrix Visuals

Filtering with Date Slicers

Editing Power BI Report Interactions

Adding Drillthrough Filters

Section 4: DAX Introduction

Data Analysis Expressions (DAX) is the formula language used in Power BI for

creating custom calculations. We’ll understand how to build measures, use

common DAX functions and understand the role of filter context.

Data Analysis Expressions (DAX) and Measures

Filter Context in Power BI

Common DAX Function : Date & Time, Conditional, Logical, Text and

Window

DAX Information Functions

Basic Math in Power BI and Index Functions

Power BI - DAX Trigonometric Functions
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COUNT Functions

DAX Aggregate Functions in Power BI

Power BI - DAX Depreciation Functions

Power BI- DAX Bitwise Functions

Section 5: Creating Table Relationships & Data Models

In this section we’ll explore how to structure your data effectively using data

models and table relationships in Power BI. You’ll learn how to link multiple

tables, apply normalization principles and manage relationships to build

efficient and scalable data models.

What is a "Data Model"?

Principles of Database Normalization

Understanding Data Tables vs. Lookup Tables

Creating , Managing & Editing Table Relationships | Power BI

Managing Active vs. Inactive Relationships in Power BI

Connect Multiple Data Tables in Power BI

Understanding Filters in Power BI

Hiding tables, columns and fields from Power Pivot

If you want to prepare for Job Interview or build projects Check the below

links:

Top 30 Power BI Interview Questions and Answers

Power BI Project ideas for Data Science
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What is Business Intelligence?
Last Updated : 12 Jul, 2025

Business Intelligence is the talk of a new changing and growing world that can

be defined as a set of concepts and methodologies to improve decision-making

in business through the use of facts and fact-based systems. The Goal of

Business Intelligence is to improve decision-making in business ideas and

analysis. Business Intelligence is not just a concept; it’s a group of concepts and

methodologies. Business Intelligence uses analytics and gut feelings for making

decisions.

In this article, we will learn about what Business Intelligence is, its role, and

its process. We will also delve into its use cases, advantages, and

disadvantages. Let's get started!!

Table of Content

Business Intelligence Overview

Role of Business Intelligence

Process Used in Business Intelligence

Types of Users of Business Intelligence

Types of Decisions Supported by Business Intelligence

Applications of Business Intelligence

Comparison Table: Popular Business Intelligence Tools

Business Intelligence Overview

Business intelligence refers to a collection of mathematical models and

analysis methods that utilize data to produce valuable information and insight

for making important decisions.

Main Components of Business Intelligence System:

1. Data Source

2. Data Mart / Data Warehouse

€“ Data visualization Pandas Seaborn Matplotlib Plotly Altair Bokeh Pygal Exploratory Data Analysis

SSearch...
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3. Data Exploration

4. Data Mining

5. Optimization

6. Decisions

1. Data Source

The first step is gathering and consolidating data from an array of primary and

secondary sources. These sources vary in origin and format, consisting mainly

of operational system data but also potentially containing unstructured

documents like emails and data from external providers.

2. Data Mart / Data Warehouse

Through the utilization of extraction and transformation tools, also known as

extract, transform, load (ETL), data is acquired from various sources and saved

in databases designed specifically for business intelligence analysis. These

databases, commonly known as data warehouses and data marts, serve as a

centralized location for the gathered data.

3.Data Exploration

The third level of the pyramid offers essential resources for conducting a

passive analysis in business intelligence. These resources include query and

reporting systems, along with statistical methods. These techniques are

referred to as passive because decision makers must first develop ideas or

establish criteria for data extraction before utilizing analysis tools to uncover

answers and confirm their initial theories. For example, a sales manager might

observe a decrease in revenues in a particular geographic region for a specific

demographic of customers. In response, she could utilize extraction and

visualization tools to confirm her hypothesis and then use statistical testing to

validate her findings based on the data.

4.Data Mining
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The fourth level, known as active business intelligence methodologies, focuses

on extracting valuable information and knowledge from data. We will delve

into various techniques such as mathematical models, pattern recognition,

machine learning, and data mining. Unlike the tools discussed in the previous

level, active models do not rely on decision makers to come up with hypothesis

but instead aim to enhance their understanding.

5.Optimization

As you ascend the pyramid, you'll encounter optimization models that

empower you to choose the most optimal course of action among various

alternatives, which can often be quite extensive or even endless. These models

have also been effectively incorporated in marketing and logistics.

6.Decisions

At last, the pinnacle of the pyramid reflects the ultimate decision made and

put into action, serving as the logical end to the decision-making process.

Despite the availability and effective utilization of business intelligence

methodologies, the decision still lies in the hands of the decision makers, who

can incorporate informal and unstructured information to fine-tune and revise

the suggestions and outcomes generated by mathematical models.

Role of Business Intelligence

The characteristics of a business intelligence analysis can be summarized by a

rational and methodical approach.

Firstly, the objectives are clearly identified and performance indicators are

chosen to evaluate different options.

Next, mathematical models are created by utilizing the connections between

control variables, parameters, and evaluation metrics.

Finally, "what-if" scenarios are explored to understand the impact of

changing control variables and parameters on performance.

Process Used in Business Intelligence
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BI (Business Intelligence) uses a set of processes, technologies, and tools

(such as Informatica/IBM) to transform raw data into meaningful information

and then transform information to provide knowledge. Then afterwards some

beneficial insights can be extracted manually and by some software then the

decision-makers can make an impact decision on the basis of insights.

To sound short and clear – Business Intelligence provides accurate information

in the right and ethical format to the decision-makers of the organization. Some

Important features of Business Intelligence are:

Fact-based decision making.

360 degrees perspective on your business.

Measurement for creating KPI (Key Performance Indicators) on the basis of

historic data fed into the system.

Identify the benchmark and then set the benchmarks for different processes.

Identify market trends and also to spot business problems that need to be

identified and solved.

Types of Users of Business Intelligence

Analyst (Data Analyst or Business Analyst): They are the statistician of the

company, they used BI on the basis of historical data priorly stored in the

system.

Head or Manager of the Company: Head of the company uses Business

Intelligence used to increase the profitability of their company by increasing

the efficiency in their decisions on the basis of all the knowledge they

discovered.



Small Business Owners: Can be used by a small businessman because it is

quite affordable too.

Government Officials: In the decision-making of the government.

Types of Decisions Supported by Business Intelligence

Strategic Level: The strategic level is the level where the Heads of the

company decide the strategies of any business.

Tactical Level: Once the strategy is made though for handling all the details

and matters have a tactical level where all the technologies and

methodologies come under one umbrella. This level is further responsible

for continuously updating the data.

Operational Level: Operation decisions are made at this level. Operational

decisions help in operating the system.

Applications of Business Intelligence

In Decision Making of the company .

In Data Mining while extracting knowledge.

In Operational Analytics and operational management.

In Predictive Analytics.

In Prescriptive Analytics..

In Executive Information System (EIS).

Comparison Table: Popular Business Intelligence Tools

BI Tool Description Key

Features

Platform Strengths

Tableau A data

visualization

and business

intelligence

tool that

allows users

to connect to

various data

Data

visualization,

dashboard

creation, data

connection,

sharing

insights.

Desktop,

Cloud

Excellent

visualizations,

user-friendly,

strong

community

support.



BI Tool Description Key

Features

Platform Strengths

sources, create

interactive

dashboards,

and share

insights.

Microsoft Power

BI

A cloud-based

BI tool that

allows users

to connect to a

wide range of

data sources,

create

visualizations,

and

communicate

findings.

Data

connection,

visualization,

cloud service

integration,

sharing

reports.

Cloud,

Desktop

Integrates wel

with Microsoft

products,

affordable,

large user

base.

QlikView A platform for

data analysis

and

visualization

that helps

users create

interactive

dashboards

and explore

data in

different ways.

Data

exploration,

interactive

dashboards,

associative

data engine.

Desktop,

Cloud

Powerful

associative

model, strong

for self-service

BI, great data

exploration

features.

SAP

BusinessObjects

A full BI suite

that includes

tools for data

visualization,

Reporting,

analytics,

data

visualization,

On-

premises,

Cloud

Comprehensive

suite, strong

enterprise

support, works



BI Tool Description Key

Features

Platform Strengths

reporting, and

analytics.

integration

with SAP

data sources.

well with SAP

systems.

IBM Cognos A BI tool for

performance

management

and corporate

intelligence

that helps

build reports,

dashboards,

and

scorecards.

Reporting,

dashboards,

performance

management,

analytics,

integration

with

enterprise

systems.

Cloud,

On-

premises

Excellent for

large

organizations,

strong

governance

features,

customizable.

Oracle Business

Intelligence

A

comprehensive

BI suite with

tools for

reporting,

analytics, and

data

visualization.

Data

visualization,

reporting,

analytics,

integration

with Oracle

databases.

On-

premises,

Cloud

Powerful

reporting and

analytics,

integrates wel

with Oracle

databases and

enterprise

systems.

Looker A BI and data

visualization

tool designed

to create

interactive

dashboards

and explore

data in

innovative

ways.

Data

exploration,

custom

dashboards,

integration

with multiple

data sources,

visualization.

Cloud

Good for

modern data

exploration,

excellent for

collaborative

analysis,

integrates with

SQL.
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Power BI - Introduction

Last Updated : 23 Jul, 2025

Power BI is a software developed by Microsoft that helps you to turn raw data

into clear and useful information. It helps to create interactive charts, reports

and dashboards so you can easily understand your data. Whether you work in

business, research or any field that uses data Power BI makes it easier to find

patterns, spot trends and make better decisions.

Introduction to Power BI

Why Do We Need Power BI?

It is a important tool for transforming raw data into valuable insights. It’s not

just about creating reports it’s about understanding complex data in a simple

and efficient way. Below are reasons why it is important:

Data Visualization: It turn complex data into clear and simple charts, graphs

and dashboards. This makes it easy to quickly spot trends and patterns in

our data.

Improved Decision-Making: It helps us to create reports that highlights

most important areas, all the key information is in one place so you can
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quickly make decisions based on data.

Real-Time Data Analysis: By using it we can keep track of our data in real

time and set up live dashboards to monitor how things are going. This is

used in sales, operations or customer support who need to respond changes

quickly.

Easy Access to Data from Multiple Sources : It allow us to connect to

various data sources like Excel, SQL databases and cloud services such as

Google Analytics or Salesforce.

User-Friendly Interface: We can just drag and drop our data into charts and

graphs with no coding required. Also it offers templates and visuals to help

us get started quickly even if we’re new to data analysis.

Key Components of Power BI

Power BI consists of several parts each have a unique role in the data analysis

process:

Power Bi Components

Power BI Desktop: This is the free version you can install on your computer.

It lets you connect to data, clean it and create reports.

Power BI Service: This is the online version. You can upload your reports

here share them with others and view them from anywhere using the

internet.

Power BI Mobile: There are mobile apps for iOS and Android and you can

use them to see and interact with your reports on your phone or tablet.



Power BI Gateway: This helps you to connect data from your own

company’s servers to Power BI and you can use that data in your reports and

dashboards.

Power BI Report Server: This provide companies to keep and share Power

BI reports on their own private server instead of using the cloud.

Power BI Embedded: It allow businesses to add Power BI reports into their

own apps or websites. People can view the reports without opening Power

BI separately.

Step-by-Step Guide to use Power BI

Getting started with Power BI is easy. Here’s a simple guide to help you:

Working of Power BI

Step 1: Download Power BI Desktop

Go to the Microsoft website and download Power BI Desktop for free. Install

it on your Windows computer.

This version is free and lets you create reports and dashboards. Once

installed you’ll get a clean workspace to begin working with your data.

Step 2: Connect to Your Data

Open Power BI and click on “Get Data.” You can choose different sources like

Excel files, SQL databases or online tools like Google Analytics or

Salesforce.

Pick your data source and follow the steps to bring the data into Power BI

and can also combine data from different sources into one report.



Step 3: Clean and Transform Your Data

Before you use your data it’s important to clean it Power BI has a tool called

Power Query which helps to remove any unnecessary information, fix data

types and handle missing values.

This step ensure that your data is accurate and ready for analysis and make

it easy to work with and find insights from it.

Step 4: Create Visualizations

Now it’s time to turn your data into visuals. Just drag and drop fields onto

the report area. Power BI will make charts, graphs or tables for you.

You can choose the type of visualization that best represents your data and

allow you to see trends, patterns and key metrics clearly. Visualizations

make your data more understandable and provide insights.

Step 5: Build a Dashboard

After making visuals you can organize them into a dashboard dashboard is a

single page with many visuals.

This makes it easy for viewers to explore the data further by clicking

elements to get more details by creating a dynamic and engaging experience

for anyone looking at the dashboard. Dashboards can also be customized to

focus on the most important data for your audience.

Step 6: Share Your Work

When your report or dashboard is ready, you can publish it to Power BI

Service (online). It allow you to share it with others so they can view it

anytime.

You can also set up automatic updates to ensure that your data stays fresh

so your reports and dashboards are always up to date. You can also share

your work in Power BI makes it easy for team members or stakeholders to

access the latest data anytime.

Tips for Using Power BI Effectively

https://www.geeksforgeeks.org/power-bi/query-editor-in-power-bi-for-data-transformation/
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Learn DAX for Advanced Calculations: DAX is a formula language that can

help you perform advanced calculations. If you want to create more complex

analytics learning DAX is a good idea.

Master Power Query: Power Query helps you to prepare your data. The

more you learn about it the more efficient your workflow will be.

Stay Organized: When you create more reports it's important to keep things

organized by giving fields, calculations clear and descriptive names.

Explore Templates: It has many templates for different industries. Use them

to get started quickly and spark new ideas for your own reports.
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Power BI - Key Components

Last Updated : 23 Jul, 2025

Power BI is a data visualization and business intelligence tool created by

Microsoft. It helps us to turn raw data into easy to understand reports and

interactive dashboards which non-technical users can also create easily. In this

article, we will understand its key components.

Components of Power Bi

1. Power Query

Power Query is the first step in working with data in Power BI. It allows you

to connect to different data sources like Excel files, databases, web pages or

even cloud-based services. Once the data is imported Power Query helps

you to clean, transform and shape it into a useful format.

We can remove unnecessary rows, change column names, combine data

from multiple tables and much more all without programming using Power

BI. This process is called “data wrangling" and Power Query makes it easy

and visual.
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2. Power View

Power View helps us to create visuals and reports by simply dragging and

dropping data fields. It support wide range of chart types like bar charts, pie

charts, line charts, maps and more.

It’s interactive which means you can click on parts of the chart to filter other

parts of the report. It is mainly used to explore your data visually and

discover trends. It is helpful for users who prefer to see patterns through

visuals rather than numbers.

3. Power BI Desktop

Power BI Desktop is the main platform where most of the work happens. It

combines all the features like Power Query (for cleaning data), Power Pivot

(for modeling data) and Power View (for visualizing data) into one tool. This

is where you build complete reports and dashboards.

This interface is user-friendly and it allows you to design everything offline

before publishing it online. It is like workshop were we prepare everything

here before sharing it with our team or organization.

4. Power BI Service

After we create our reports in Power BI Desktop you can publish them to

the Power BI Service which is also known as the Power BI Website. Here

we can share your reports with others, collaborate in teams and access your

data from any device using a browser.

It’s a cloud-based platform that also lets us schedule data refreshes and

receive automatic updates. We can also create dashboards here by pinning

visuals from different reports into one view for easy monitoring.

5. Power Pivot

Power Pivot is the engine behind the scenes that helps you work with large

datasets quickly. It lets you create data models which means you can link

different tables together and use formulas (called DAX formulas) to perform

calculations.



Even if you have millions of rows it compresses the data and processes it

efficiently. This is great for building powerful reports without slowing down

your system. It’s especially useful for users who want to do in-depth

analysis.

6. Power Map

Power Map is used when your data includes geographical locations like

countries, cities or coordinates. It creates 3D maps that let you view your

data based on location. You can see patterns like sales by region, customer

distribution or delivery routes.

The maps are animated and you can even show changes over time. For

example, how sales grew across different areas month by month.

7. Power Q&A

Power Q&A is like talking to your data using natural language. You don’t

need to know any query language just type a question like “Show total sales

for 2024” or “Top 5 selling products” and Power BI will understand and give

you the answer instantly in the form of a chart or graph.

It uses smart algorithms to understand your words and give meaningful

answers. This feature makes data analysis more accessible to people who

may not be experts.

8. Power BI Mobile Apps

Power BI has mobile apps for iPhone, Android and Windows devices. These

apps allow you to access your reports and dashboards anywhere and

anytime. You can view the latest data, check KPIs and stay updated on

business performance while traveling or during meetings.

The mobile interface is designed to be clean and responsive so you can scroll

through your visuals easily even on a small screen.

Power BI brings together powerful tools to connect, analyze and visualize data

in one place. Its flexible components make it easy for anyone to turn raw data

into meaningful insights.
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Power BI - Practical Applications

Last Updated : 23 Jul, 2025

A feature of Microsoft Office 365 called Power BI gives business users access

to insights from their data. Users of the software can visualize information using

a range of tools, such as graphs and diagrams. In other words, Power BI serves

as a link between your data and the individual who will ultimately utilize it to

make crucial decisions. Power BI is a tool that businesses frequently utilize for

informational purposes. When various departments collaborate on a project, for

instance, it may be necessary to transmit information across them in such a way

that everyone can understand. So that everyone is on the exact page as they do

their individual jobs.

Applications of Power BI

1. Visualize Details Easily

Microsoft Power BI provides such tools that will let you visualize key data

points accurately from various sources in a single dashboard. For instance, you

can have a dashboard that displays the different products in your store,

allowing you to track sales, costs, and expenses in one location. This will help

managers at the same time that they keep their employees updated on sales

and expenses.

2. Real-Time Performance

You can understand the Real-Time performance of enterprises on a variety of

levels using Microsoft Power BI. For instance, have a dashboard that lists all of

the projects that are active as well as their due dates. On these projects, you

may also keep a close watch on how each individual employee is doing. This is

a fantastic way to tell your team of changes and deadlines, keep them informed
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of one other's duties for certain tasks, and even allow the staff to keep an eye

on their own performance.

3. Sales Analysis

Another common use for business intelligence tools like Power BI is sales

analysis. Multiple dashboards that display charts can be set up to monitor user

activity throughout an online session. Additionally, what product categories do

your clients purchase the most frequently, or which geographical areas

generate the highest revenue for you? You can adjust your business practices

based on this knowledge to better meet the needs of your clients and boost

sales.

4. Improving Marketing

These dashboards can show all kinds of data to assist you to enhance your

marketing campaign if you or the rest of your team are working on any kind of

extensive marketing effort. The software can track parameters like the price at

which each product is sold individually and present all of this data so that you

may develop a more successful marketing plan for upcoming campaigns.

5. Create Consistent Reporting Standards

You may gather the data and produce reports using Power BI to give you

consistent reporting. If the data is delivered in a graphical manner each time, it

is less stressful for the managers, and takes less time to find insights from it,

and the organization may find it helpful to predict information. Additionally, it

enables you to carry out targeted marketing initiatives that are guaranteed to

be effective.

6. Controlling Costs

The average cost of each campaign that has been running on your website can

be displayed on a dashboard. This can assist you in determining which

promotions will benefit your clients and your organization. It also assists you in



deciding how much money to spend on anything in the future. You can also

develop dashboards that show how much money is being spent on each

specific campaign this will help to have proper control of the cost of each

product which leads to control of the overall cost of the organization.

7. Product Development

Another typical use for business intelligence software like Power BI is product

development. When it's time to pull one product off the market and replace it

with a newer and more successful one, This dashboard shows how much

money is being produced for each particular product that can help your

organization.

Practical Applications of Power BI

Power BI is a Microsoft tool that allows you to use datasets from multiple

sources and create reports and charts to address specific business needs. Using

Power BI is about providing practical solutions for real-world problems, making

it the perfect tool for organizations seeking quick and easy insights with

minimal effort. Let's see by creating a simple Line chart in Power BI of the

Financial sales analysis dataset. Let's see the different practical applications of

Power BI:

Financial Sales Analysis in Power BI

On launching the Power BI Desktop App, we get an option to Try the sample

dataset; by clicking on that option, we can import the sample Financial dataset

and start using it to create our Power BI Report. 



The dataset gives insights into the Sales and Profits of certain products

belonging to different segments in multiple countries over 2013-14. It

comprises the following columns by default:

https://download.microsoft.com/download/1/4/E/14EDED28-6C58-4055-A65C-23B4DA81C4DE/Financial%20Sample.xlsx


Step 1: First, navigate to the Data Tab and select the Table Tools options from

the top navigation bar. Select the New Column option from the table tools and

opportunities to create a new custom column.

Step 2: On clicking the New Column option, an input bar will appear where we

will write a simple DAX expression to create our columns.



Step 3: In DAX, we can access a particular column using the following syntax -

tableName[columnName],The following DAX Expression creates a new column

named TotalManufacturingPrice.

     TotalManufacuturingPrice = financials[Manufacturing

Price]*financials[Units Sold]



Step 4: Now, using this newly created column, we make our ProfitPercentage

column using the below expression.

ProfitPercentage =
(financials[Profit]/financials[TotalManufacuturingPrice])*100 

Step 5: Now, Select the Line chart from the Visualization. Drag the segment

and drop to the X-axis, Again drag the ProfitPercent and drop to the Y-axis

that we have created our custom columns, we can use a line chart which comes

out to be like this:



Profit Analysis using Donut Chart in Power BI

Next, we will create another custom column called ProfitType to tell if the

profit is positive, negative, or null. This can be done by using the IF function in

the DAX Expression like this:

ProfitType = IF(financials[Profit]

<0,"Negative",IF(financials[Profit]>0,"Positive","NULL")) 

Step 1: From the top navigation bar, select the New Column option from the

table tools and opportunities to create a new custom column.



Step 2: Select the donut chart from the Visualization. From the field, option

drag the ProfitType and drop to the values and details. This newly created

column can be further used to create a donut chart, as shown below:

Analysis of most profitable day using Bar Chart in Power BI

Suppose we also want to analyze which day of the week has the most

significant number of sales or profit; so for this, we can create an additional

column, Weekday, by extracting the day of the week from the Date Column

already provided using the DAX WEEKDAY function like this:



Weekday = WEEKDAY(financials[Date].[Date],2)

Here, the second parameter of the function refers to the return type. 

If return type = 1, week begins on Sunday (1) and ends on Saturday

(7). numbered 1 through 7.

If Return type = 2, week begins on Monday (1) and ends on Sunday (7).

If Return type = 3, week begins on Monday (0) and ends on Sunday

(6).numbered 1 through 7.

For the above function return type is 2, i.e the week begins on Monday.

Step 1: On clicking the New Column option, an input bar will appear where we

will write a simple DAX expression to create our columns.
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Step 2: Using this custom column, we can plot the following bar chart and

conclude that we get Maximum Profits on Tuesdays (Weekday = 2) 
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How to Install Power BI on Windows?

Last Updated : 23 Jul, 2025

Power BI is a business analytics tool developed by Microsoft where "BI" stands

for Business Intelligence. It is used to connect, visualize and analyze data from

various sources. You can create interactive dashboards, reports, graphs and

charts with just a few clicks. Power BI also helps with data cleaning,

preparation and discovery.

Note: Power BI Desktop is available only for Windows operating systems.

Steps to Install Power BI on Windows

Follow these simple steps to install Power BI on your Windows computer:

Step 1: Open the Official Power BI Website

Open any web browser like Chrome or Edge and go to the official Power BI

website.

Step 2: Go to the Power BI Desktop Section

DSA Practice Problems C C++ Java Python JavaScript Data Science Machine Learning Courses

SSearch...

https://www.geeksforgeeks.org/power-bi/power-bi-rise-of-microsoft-power-bi-as-a-data-analytics-powerhouse/
https://www.geeksforgeeks.org/power-bi/power-bi-rise-of-microsoft-power-bi-as-a-data-analytics-powerhouse/
https://www.geeksforgeeks.org/dsa/dsa-tutorial-learn-data-structures-and-algorithms/
https://www.geeksforgeeks.org/explore
https://www.geeksforgeeks.org/c/c-programming-language/
https://www.geeksforgeeks.org/cpp/c-plus-plus/
https://www.geeksforgeeks.org/java/java/
https://www.geeksforgeeks.org/python/python-programming-language-tutorial/
https://www.geeksforgeeks.org/javascript/javascript-tutorial/
https://www.geeksforgeeks.org/data-science/data-science-for-beginners/
https://www.geeksforgeeks.org/machine-learning/machine-learning/
https://www.geeksforgeeks.org/courses


On the homepage click on the “Download Power BI Desktop” option.

Step 3: Click on the Download Button

You will be taken to a new page. Click on the Download button to start the

process.

Step 4: Choose the Installer Based on Your System

On the next webpage choose the setup option according to your system

configuration, let's take the first setup click on the Next button. Downloading of

the executable file will start shortly. It is a big  361.7 MB file that will take

some minutes.



Step 5: Find the Downloaded File

Now check for the executable file in downloads in your system and run it.

Step 6: Run the Installer

Double-click on the file. If prompted with a security warning click Run.



Step 7: Select Your Language

Choose your preferred language and click Next.

Step 8: Allow Changes to Your System

A pop-up will ask for permission to make changes to your system. Click Yes.



Step 9: Setup Will Start

Power BI will now begin preparing for the installation.

Step 10: Start Installation Setup

Click Next on the setup welcome screen.



Step 11: Accept the License Agreement

Check the box that says “I accept the terms in the License Agreement” and click

Next.

Step 12: Choose Installation Folder

You can either keep the default location or choose a different one. Then click

Next.

Step 13: Begin Installation

Click on the Install button. Installation will start and usually takes a minute or

two.



As you can see the installation is started in the below image

Step 14: Complete Installation

Once done click on the Finish button.



Step 15: Launch Power BI

A shortcut icon will appear on your desktop. Double-click it to open Power BI

Desktop.

Now we run the software and see the interface.
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Congratulations! At this point you have successfully installed Power BI on your

windows system. You can now start exploring your data and building reports in

easy manner.
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Power BI - Data Sources and its type

Last Updated : 07 Jun, 2025

In Power BI a data source is simply where your data originally comes from. It

could be a file stored on your computer, a database, an online service or any

other place that Power BI can connect to. These data sources are important

because they provide the basic information that Power BI uses to create

datasets. Once the data is imported you can use it to build clear and interactive

visuals, reports and dashboards.

How to Find Data Sources in Power BI

If you want to find and manage your data sources in Power BI Desktop here’s

how you do it:

1. Go to the Home tab at the top of the Power BI window.

2. Click on the Get Data button. This will show you a list of the most common

types of data sources.

3. If you want to see the full list of available data sources and click on More.

This opens a window where you can browse all the types of data you can

connect to.
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Get Data

As seen in the screenshot above, click the "More." option opens a new

navigation window with a category of all accessible data sources on the left

side. Additionally a search option is at the top as shown in the screenshot

below.



Data Sources

Types of Data Sources in Power BI Desktop

As mentioned above Power BI Desktop categorize data sources into several

types below you can explore examples of what data sources there are in Power

BI:  

File Data Sources

The File data sources in Power BI include several common file types that you

can use to import data. These include Excel workbooks, Text or CSV files,

XML files and JSON files. You can also connect to a whole Folder containing

multiple files, PDF documents and even SharePoint folders.

These file types are some of the most popular ways to bring data into Power

BI especially when working with data stored locally or on shared drives.



File Data Sources

Database Data Sources

A list of all the database connections you can connect to is displayed when

the user selects the Database option. Choose a database type from the list

as shown in the screenshot below to connect to any database. Go to

Connect. To connect the user must enter the server name, user name and

password.

Using the advanced settings you can also connect by using a straight SQL

query. Additional connectivity options include Import and DirectQuery.



Database Data Sources

Azure Data Sources

The Azure category in Power BI includes data sources that come from

Microsoft’s cloud platform. You can connect to services like Azure SQL

Database, Azure Synapse Analytics, Azure Analysis Services and Azure

Database for PostgreSQL.

These options are helpful when your data is stored in the cloud allow you to

access and analyze it directly from Power BI without need to download

anything locally.



Azure Data Sources

Online Services

The Online Services category in Power BI lets you connect to different web-

based tools and apps that many businesses use every day. For example you

can bring in data from SharePoint Online Lists, Microsoft Exchange Online

and different versions of Dynamics 365 including Business Central and

Dynamics NAV.

You can also connect to popular analytics tools like Google Analytics and

Adobe Analytics as well as services like LinkedIn Sales Navigator and Twilio.

This makes it easy to pull data from the online tools you already use and

create reports and dashboards in Power BI without need to move the data

manually.



Online Services

Other Data Sources

The Other category in Power BI includes a mix of different data sources that

don’t fit into the main groups. Some examples are Web, SharePoint list,

Active Directory, Microsoft Exchange and Python script.

You can even start from scratch using a Blank Query. This category is helpful

when your data comes from less common or more advanced sources.



Corporate & Communications Address:

A-143, 7th Floor, Sovereign Corporate
Tower, Sector- 136, Noida, Uttar Pradesh

(201305)

Registered Address:

K 061, Tower K, Gulshan Vivante
Apartment, Sector 137, Noida, Gautam
Buddh Nagar, Uttar Pradesh, 201305

Other Data Sources

Power BI Desktop can connect to a wide variety of data sources. The exact

number of data sources is constantly expanding as Microsoft continuously

updates Power BI to support new sources. Currently Power BI supports

hundreds of different data connections. 
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Differences Between Microsoft Power BI and SSRS

Last Updated : 23 Jul, 2025

SSRS and Power BI are both Business Intelligence (BI) tools that are made to

show data to users in a easy to understand way. Even though Microsoft made

both but they are designed for different types of users and used for different

purposes. In this article, we will see the differences between Power BI and

SSRS to know which tool best suits our specific needs.

Understanding SSRS

SSRS stands for SQL Server Reporting Services is a tool used to create

visualizations and reports on data such as graphs, tables, charts, etc. It consists

of tools for create, distribute and manage reports. It provides insight from

information stored in SQL databases and helps to make important decisions

based on reports generated by SSRS. 

Features of the SSRS

No Additional Costs: It is free with SQL Server and helps us to reduce

reporting expenses.

Mobile-Friendly: This allows us to view reports generated from your mobile

device. Generates a URL that you can use to open your report from any

device, anytime, anywhere using Internet.

Advanced Analytics: It can generate reports in form like graph, chart and

tabular format.

Microsoft Development Environment: It uses a feature-rich and user-

friendly development environment.

Understanding Power BI

Power BI stands for Power Business Intelligence. It is capable of generating

various reports and dashboards from different data sources. It helps businesses
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to share reports and visualizations with the stakeholders to take important

business decisions. It comes in free and paid versions. The free version provides

limited functionality whereas the paid version has much more advanced

functionality.

Features of Power BI

Interactive Dashboards: Creates visually rich and interactive dashboards

and reports.

Real-Time Data: Supports real-time data streaming and updates.

Data Modeling: Allows data transformation, relationships and calculated

fields using DAX.

AI Integration: Uses Microsoft AI for advanced analytics and natural

language queries.

Mobile Access: Access and interact with reports using its mobile app for iOS

and Android.

Difference between Power BI and SSRS

Let's understand the difference between the Power BI and SSRS

Feature Power BI SSRS

Long Form It Represents Power Business

Intelligence.

It refers to SQL Server

Reporting Services.

Developer and

Release
Developed by Microsoft and

released in 2017.

Developed by

Microsoft and released

in 2004.

License

Has both paid and free versions 

This is a free

application that comes

with SQL Server.



Feature Power BI SSRS

Accessibility  Accessible through the web

(Power BI service), desktop (Power

BI Desktop) and mobile app.

Accessible via the

Internet and the

desktop.

File Size
The maximum file size is 250 MB.

The file size is

unlimited.

Reports Reports are generated both on the

server and in the cloud.

Reports are server-

based.

Data

Supported
Supports structured and

unstructured data.

Supports structured

and semi-structured

data.

Update

Frequency

Updates for Power BI are released

monthly.

SSRS gets updates

every few years.

Complexity 
Easy to use GUI

Requires a user to

know SQL queries.

Power BI and SSRS are both great tools, but they are made for different

purposes. If you need interactive and easy-to-share reports Power BI is the best

option. If you need formal, printable reports SSRS is the better choice.
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Power BI Free vs Power BI Pro vs Power BI Premium

Last Updated : 08 May, 2025

Power BI is a tool developed by Microsoft to help users connect to

various data sources and create interactive reports. It allows you to

visualize your data in a way that makes it easier to see patterns and

insights. Power BI was built using some of the features from Excel, like

Power Query, Power Pivot, and Power View to help you analyze and

visualize your data. It works together with these first three fundamentals:

Power BI Desktop: A desktop application for data extraction, data

modeling, dashboard creation and report creation. Windows desktop

software called Power BI Desktop.

Power BI service: An online SaaS (Software as a Service) application

is the Power BI service.

Power BI Mobile Apps: Power BI offers mobile apps for Android, iOS,

and Windows that allow user to interact with Power BI dashboards

and reports.

Power BI Desktop Or Power BI Free

Power BI Desktop is a free app you can install on Windows. It helps to

connect to many types of data sources like Excel, Azure, Salesforce,

SharePoint, JSON, XML and ODBC databases. You can clean, combine

and transform your data and build interactive reports. But you can not

share reports online without upgrading. A basic interface of the Power

BI Desktop can be seen below:
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Power BI Pro

The main difference between Pro and Free is that users who have a

Power BI Pro license can access each other's data, reports and

dashboards when using Pro. Additionally you can make App workspaces.

There is a 10 GB per Pro user data storage limit for Power BI Free and

Pro. A below shown comparative analysis would be displayed if you try

to start your Power BI Pro journey while purchasing the license. Pro users

can share content and work with free and PPU users if a Power BI

Premium capacity holds the content.



Power BI Premium

Power BI Premium uses the Power BI Report Server to deploy and

distribute Power BI reports. It improves speed, handle bigger workloads

and removes the need for individual licenses for viewers. Premium plans

vary based on memory and processing power and help businesses to

scale better. These features can be summarized as shown below:



Power

With a Power BI Premium Per User (PPU) license you get all Power BI

Pro features plus Premium features like advanced AI, big data prep and

faster performance. Only users with a PPU license can access PPU

workspaces. To share content everyone must have a PPU license unless

the workspace is in Premium capacity. Microsoft provides Power BI Pro

and Premium pricing currently as follows:



Difference between Power BI Free, Power BI Pro and

Power BI Premium

Good for Personal use and learning with real-time dashboards and

reports.

Features Power BI Free Power BI Pro Power BI

Premium

License type
Power BI Free per-

user license

Power BI Pro

license

Power BI

Premium per user

(PPU) license

Sharing with

Others

Accessibility

towards the

content they

produce on their

own.

Share

dashboards,

publish

material to

other

workspaces

subscribe to

dashboards

Share

dashboards,

publish material

to other

workspaces,

subscribe to

dashboards and

reports and share



Features Power BI Free Power BI Pro Power BI

Premium

and reports

and share with

Pro-licensed

users.

with PPU-

licensed users.

Premium

Workspace

Features

Consume material

that Pro or PPU

users have shared

with them.

Provide

material to

users with PPU

or free

licensing.

Make material

available to

consumers with

both free and paid

licenses.

Max Storage 10 GB/User 100 TB 100 TB

Pricing

Free
$9.99

Per user/month

$20

Per user/month 

$4,995

Per

capacity/month

Advantage Users can make

data preparation

easier, get insights

faster and manage

data more

efficiently across

the business by

buying licenses.

Scalable for

large teams no

need for

individual

licenses for

viewers and

advanced

features

Ideal for

organizations no

need to buy

individual licenses

for viewers.

Disadvantage The free Power BI

option only lets

Individual

licensing for

You can't create

reports or
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Features Power BI Free Power BI Pro Power BI

Premium

you work on your

own computer.

You can't share,

collaborate or

publish reports.

It's good for

learning or

experimenting

alone or in a

shared network.

every user

within the

same

organization is

costly.

manage

dashboards with

the free version.

To make reports

users need to buy

individual Power

BI Pro licenses.

Microsoft provides both of these choices Pro and Premium as a monthly

subscription service. You can connect to more than 70 data sources,

publish content online and export data to Excel using Power BI Free. The

free version has several restrictions.
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Power BI - How to edit in Power BI App?

Last Updated : 09 Feb, 2023

Power BI is a data visualization application that lets you connect, transform and

find insights into the most pressing matters of your business. It helps in

sourcing your data and creating visual dashboards, KPIs, and reports by editing

the data as per your concerns. You can collaborate, share and integrate your

data easily across products documentations. It also has a wide range of

visualizations, including charts, tables, and maps, and allows users to create

interactive dashboards and reports. Power BI is widely used for data analysis,

reporting, and business intelligence. With a cut-down risk of the

misgovernment of data, including when data is exported out of your

application, it proves worthy of use. Power BI is compelling in the case of

compressing the data with millions and billions of rows.

Use of Power BI
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SSearch...
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It is mainly used to create visualized reports and dashboards through which you

can learn more about your data. Uploading your report to the Power BI service

enables you and your users to interact and track the report being used. Here,

we will go through the steps required for you to create and edit Reports and

Dashboards.

Basic Steps Required:

1. Extract the data

2. Transform the data as required and change the relationship between the

tables using a power query.

3. Use DAX to perform the calculation on your data.

4. After getting your data ready, you can jump to your visualizations.

5. Add the graphs, charts, cards, etc., and create edits within them to make your

report look more understandable.

6. Upload your dashboard to the cloud enabling your colleagues to access the

dashboard and report.

Loading data

Let’s start with how you can load data in your application. You can load your

data from the 'Get data' option in the home tab. You can select from the

following options:

Files: Power BI can import statistics from Excel, CSV, and other record

formats.

Databases: It can connect to several databases, which include MySQL,

Oracle, and SQL Server.

Direct Query: It can retrieve the desired dataset by connecting to a data

source without importing it beforehand.  

Online Services: It can connect to various online services for example Google

Analytics, SalesForce, and SharePoint.

Live Connection: An up-to-date live connection with a data source in real-

time allows users to retrieve up-to-date data. 



After the data gets loaded into the application, you can begin transforming and

modeling your data. You can select add new column option with custom

options, and make your own calculated field column.

Step 1: For this step Select "Data" from the three options on the left margin.



Step 2: Select "New Measure" from the "Calculation" section in the "Table

Tools" tab.

Step 3: Now you can get your desired functions with the table field's name and

thus you'll be able to create a new column.



Step 4: After this step, you'll complete your required columns or measures. You

should use the "New Column" method when you require this column to be

present at data refreshes as well because it gets defined in the table. Whereas

measure works as a filter on your table and it is faster because they are not

stored in the memory. Power BI has a built-in Power Query Editor that makes

your data visuals-ready. It allows you to make advanced changes to clean your

data for perfect visualizations and get your model done.

Note: Reports in Power BI use only a single dataset whereas dashboards

use many datasets.



Power Query

Power Query is used to transform data by performing tasks such as filtering,

grouping, and pivoting. It helps to create calculated columns and measures by

using the formula bar and functions. After the cleaning and transformation of

your data, you can move on to your visualizations. Following are the steps to

use Power Query.

Step 1: Select "Home" from the top menu.

Step 2: From the queries section select “Transform data”.[(A new window will

open with Power Query Editor),(If no data connection is made yet then it'd

show a blank page)].

Step 3: On this page you'll get to add, change, view, transform, and correct your

data.

The "Home" tab provides data source options.

The "Transform" tab includes addition, deletion, splitting, and changing data

types functions.



The "Add Column" tab provides the column addition and formatting of the

same.

The "View" tab provides how the page is displayed to you.

Step 4: With a right-click on your column you can make different changes.



Step 5: After making the necessary transformations, click on "Close & Apply"

by clicking on the "File" tab to save the changes and return to the Power BI

Desktop.

Your data is now ready to be used in visualizations and reports.

Note: If you want to make more complex changes to your visualizations,

you can use the "DAX" formulas to create calculated columns and

measures.

Visualization in Power BI



Format and Fields sidebar is the section to make your dashboard and report

visually attractive.

To edit the layout of a report, use the "Layout" option under the "View" tab.

(It provides various theme options to match up with your report.)

To edit the visualization after it's been added to the report, click on the

visualization and use the "Format" option to customize the visualization.



If you want to make more complex changes to your visualizations, you can use

the "DAX" formulas to create calculated columns and measures.

Dashboards in Power BI

A dashboard in Power BI is a collection of visualizations and reports that

provide an overview of key metrics and data for a specific area of interest. It

allows users to view, analyze, and share data in a visually appealing way. It

consists of a single page.

It allows the user to make changes in the visualizations i.e. involvement by the

end user as well rather than a simple summary of the data.

Note: Dashboards are only provided in the Power BI Service and not in

Power BI Desktop or Mobile. 



Types of Reports in Power BI

Reports can be shared and accessed by others inside an organization and

embedded in websites, portals, and apps. Users can also engage with the

visualizations in a file to discover the statistics and explore new insights.

Reports are something that can consist of only one visual/number of visuals or

one page/number of pages as per the requirement of your job.

To create a new report, you can select the "New Report" button in the Home

tab of the Power BI Desktop.

Once you have created a report, you can add different visualizations such as

charts, tables, and maps by dragging fields from your data source onto the

report canvas.



You can also edit the appearance of these visualizations by adjusting their

formatting options. (figure above)

To edit an existing report, you can simply open it and make the necessary

changes. 

You can also make a copy of an existing report, by right-clicking on the

report in the Power BI Service and selecting 'Duplicate Report'

These are the reports that you should be acquainted with:

1. Canvas report: This is the most basic type of report in Power BI. It allows

users to drag and drop visualizations onto a canvas and arrange them as

desired.

2. Paginated report: This type of report is similar to a traditional paper report,

with a fixed layout and the ability to add tables, matrices, and charts.

3. Dashboard: A Power BI dashboard is a collection of visualizations and other

elements that can be shared with others.



4. Data Story: A data story tells a story with the data through a collection of

multiple pages.

5. Interactive visualizations: Interactive visualizations such as maps, cards, and

gauges are used to create engaging and interactive reports.

6. KPI report: A KPI report is a type of report that allows you to track key

performance indicators and measure the performance of your business.

7. Mobile report: A mobile report is an optimized report for viewing on mobile

devices. It is designed to provide a great user experience on mobile devices.

8. Drillthrough report: A drill-through report allows users to drill down into

the data to view more detailed information.

These are some of the most commonplace types of reports that are created in

Power BI, however, there are different styles of words that can be created as

well.

Conclusion

1. Load the data from your desired data source.

2. Clean the data in excel and load the data.

3. Change the relationship and add-remove columns from the table as

required.

4. Create measures and calculated fields to complete your dataset and move

on with the visuals.
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5. Add the visuals and edit them as per your requirement from the

visualizations panel to create your report.
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